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Figure 1: These are icon designs from several talented graphic artists.  There are even more 

excellent creations within the TFR game.  We salute the creators! 

TFR Icon Creation Tutorial - Chinese 
Version 2.0 (TRANSLATED) 

Created by TFR-CN, referencing tutorials from Sudin, Rev, the 1.0 tutorial, and various 
 



 

tutorials from many experienced graphic designers. 
 

0. Preface： 
In March of 2025, the Chinese TFR production team created a 

tutorial that systematically explained the creation of icons for The 

Fire Rises. Over the following six months, this tutorial helped many 

new graphic designers take their first steps in creation, beginning to 

unleash their creativity on image editing softwares. However, with 

continuous updates of the TFR mod and the refinement of GFX artists’ 

skills through practice, the mod’s icons have made tremendous 

progress in just a few months. The old tutorial is no longer able to 

keep up with the fast-changing landscape of TFR icon creation. This 

tutorial aims to summarize creative experiences and promote new 

creative approaches. Building upon the work of experienced graphic 

designers, it provides a practical learning path for beginners and 

those who want to learn new methods of creating. If you don't know 

where to start and want to create new TFR-style icons for your fan 

works, the TFR Submod you’re developing, or for the TFR 

development team itself, your answers will be found here. 

This tutorial will provide both some basic and widely-used 

 



 

advanced techniques. If you have any questions about icon creation, 

this tutorial, or want to inquire about other icon creation methods, I 

recommend you ask me (Bondrewd) and other experienced graphic 

designers in the #fan-content, #ru-fanart, and #cn-fanart channels of 

https://discord.gg/tfr. 

Software Support： 

This tutorial is entirely based on Adobe Photoshop. Theoretically, 

icons can also be created using unofficial web-based versions of 

Photoshop such as Photopea, Paint.net, and Ibis Paint. However, due 

to its comprehensive features, extensive editing options, and vast 

number of related tutorials, Photoshop remains the best solution for 

creating TFR icons and other fan-made content for Hearts of Iron 4. 

I am using Adobe Photoshop 2024, Version 25.0.0.37. Please note 

that there may be some functional differences between newer and 

older versions of Photoshop. 

This tutorial does not provide download links, so please find the 

software resources yourself. I personally recommend that creators of 

Hearts of Iron 4 related fanart choose the 2022-2023 versions of 

Photoshop, because the newer Photoshop 2024 and 2025 versions 
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may not support the lighting effects feature, which is crucial for 

creating icons for Hearts of Iron 4 mods. The 3D features have also 

been removed in Photoshop 2024 and 2025. Older versions of 

Photoshop may have some missing features (however, for those still 

using older devices, using an older version of Photoshop can provide 

a smoother creative experience and is still a better choice compared 

to other software mentioned above). 

Image Collection： 

Source images for icons are generally sourced from search 

engines such as Bing, Google, Yandex, and Baidu. If images cannot be 

downloaded or saved properly, you can obtain them directly through 

screenshots. With the advancement of AI image generation, you can 

also choose to use AI to generate images, provided that the essential 

details remain intact. 

After collecting the images, you can use online background 

removed websites such as remove.bg and Baidu AI Image Assistant to 

quickly remove image backgrounds, but note that some complex 

scenes may require manual correction. You can also use the "Quick 

Selection" and "Select Subject" tools in Photoshop, although the 
 

http://remove.bg


 

results may vary depending on the Photoshop version. 

When collecting images, you will often encounter 

unconventional file formats. Therefore, it is recommended to install a 

tool that supports batch conversion of formats such as DDS and WebP 

to Photoshop-compatible formats (such as XnConvert), as well as 

plugins that improve Photoshop format compatibility. The quality of 

these tools varies, and some may contain adware or viruses, so please 

choose your software sources carefully. 

I have compiled a list of commonly used tool websites at the end 

of this article. You can click here to quickly go to the end of the article 

to access them. 

Regarding the “TFR Style” 

The TFR logo was once simply described by a friend as "a 

trending YouTube video thumbnail made into a Hearts of Iron IV 

icon." Although this description doesn't perfectly match the actual 

style of the TFR logo, it's sufficient to help most beginners quickly 

understand the icon's style. 

 



 

 
Figure 2 shows the Soviet economic policy tree, in standard TFR-style icons. 

Using this as an example, I will introduce some basic characteristics of TFR icons. 

Compared to the popular TNO (The New Order)-style icons, TFR 

icons are more vibrant and brighter, with a more exaggerated visual 

effect, reflecting the rapid advancements of the 2020s. Most of the 

icon materials are composed of real-world objects, with only a small 

portion using various artwork materials. Some icons also utilize 

AI-generated materials to address the difficulty in collecting 

materials for certain themes. TFR icons are mostly placed on larger, 

wider canvases without borders, and their overall shape is more 

rectangular, which is a major distinguishing feature from other mod 

icons. Of course, icon styles are not inherently superior or inferior; as 

an enthusiast of a particular art style, one should not use their 

preferences to show superiority in other modding and art 

communities, nor should they mock or belittle works and art in other 

styles. 

Due to the lack of borders, TFR icons offer greater freedom and 

 



 

openness in composition. Whether it's a simple stacking of images or 

an attempt to construct a scene, it can be considered TFR style. 

TFR icons place considerable emphasis on the overall effect of 

the national focus tree, striving for harmony in the entire set of 

national focus tree icons. Therefore, currently, the icons on a single 

national focus tree in the main mod are usually required to be created 

by the same artist from beginning to end. Thus, if you need to create 

icons for the main TFR mod or its submods, it is essential for the 

artist to try to control the overall effect of the national focus tree 

while maintaining consistent quality and improving efficiency. 

 
Figure 3: The diverse icon styles in the one-year anniversary teaser campaign. 

Of course, the creation of TFR's icons is not static. Over several 

months of development, from creative concepts to technical 

 



 

capabilities, TFR's icon style has undergone significant changes and 

made considerable progress. In the current TFR mod, the icon style 

exhibits a "blooming of a hundred flowers" phenomenon 

(Translator’s Note: ChatGPT told me this is a Chinese idiom meaning 

“diverse styles thriving simultaneously”) – our talented artists freely 

pour their inspiration and ingenuity into their creations, painting 

their unique colors in a world engulfed in flames.  

The biggest differences between the new and older TFR-styled 

icons are:： 

●​ The icons have a more three-dimensional feel, representing a 

significant improvement over the flat, paper-like texture of 

earlier icons; 

●​ Extensive use of lighting effects has been incorporated, 

resulting in more pronounced light and shadow contrasts, 

making the icons appear more dynamic and vibrant; 

●​ The composition methods are more flexible and diverse, not 

limited to just a few simple approaches; 

●​ Different styles and editing techniques from various modules 

have been integrated into the TFR icons, allowing them to 

evolve by incorporating the best aspects of different 

approaches. 

In the future, TFR's icon creation will be further developed, and I 

will update this tutorial accordingly . However, this tutorial will not 

 



 

cover all icon creation styles in detail; I will begin with a simple, 

standard TFR-style icon. 

 

1.  Basic Editing Techniques： 

In this chapter,  I will give a step-by-step explanation on how to 

create a basic TFR-style icon, starting with creating the canvas. 

Step 1: Create A Suitable Canvas 

The standard canvas size for TFR national focus icons is 170*150 

pixels, with a maximum size of 200*150 pixels. The size can be 

adjusted according to needs and preferences. It's important to note 

that when creating TFR icons, a blank space of 38 to 40 pixels should 

be left at the bottom to avoid obscuring the national focus title. 

The icon canvas width should ideally not exceed 210 pixels; 

otherwise, the adjacent national focus icons will be squeezed 

together and become cluttered after implementation. 

 
Figure 4  

The required canvas sizes for creating other types of icons can be 

 



 

found in the image below: 

 
Figure 5: Reference dimensions for various icon canvas sizes. (Translator’s Note: Excuse the bad 

translations, I just put it into google translate) 

Here, we'll first create a slightly larger canvas of 180*150 pixels; 

most of the subsequent work will be performed on this canvas. 

 
图 6 创建画布，分辨率一般设置为72像素 

Step 2: Placing the Elements 

Now, we need to find some material to serve as the main part of 

the icon. I've chosen Mr. Zhang Weiwei (yes, him again), who is very 

 



 

popular in the Chinese community, as the instructor for this icon 

tutorial – I will demonstrate the complete steps for creating a 

TFR-style national focus icon together with him. 

 
Figure 7: We meet again, and it's still the same... I like you. 

In Photoshop, we can quickly select objects using the Object 

Selection Tool or the Select Subject tool. For overly complex subjects, 

it may be necessary to manually select the object using the Lasso 

Tool. 

 



 

 
Figure 8: Koko Space is here! (Translator’s Note: That is way too small for me to translate. My 

apologies) 

It can be noticed that Zhang Weiwei's right elbow in the original 

image appears to have been cropped. In this case, the missing part 

can be easily filled in using a brush tool. 

 
Figure 9 

Then, by cropping out the unnecessary parts, the extracted 

image can be placed onto the main canvas. After placing it on the 

canvas, the image should be converted into a smart object, and then 

 



 

scaled to avoid blurring due to subsequent scaling. 

If you are concerned that a large number of large-sized smart 

objects will occupy too much computer storage space, you can try 

scaling the image to a size slightly larger than the canvas before 

converting it into a smart object. This ensures sufficient clarity for the 

icon while minimizing storage space usage. 

 

Figure 10 shows the steps. 

Before beginning further editing, please ensure that the assets 

remain as smart objects. This will greatly facilitate subsequent 

adjustments and prevent changes in icon clarity due to scaling. 

Step 3: Adding Effects 

Now, let's add a layer style to Mr. Wei Wei. 

 



 

 
Figure 11: The angle of the bevel and relief should be adjusted according to the actual situation 

and light source position; some settings are based on AhNeo's configuration. 

Please note that the layer style settings shown are for reference 

only.  If you find that these settings are no longer suitable when 

creating other icons or editing other images, you can adjust the 

values ​​and add new layer styles to make your icons more visually 

appealing. 

Additionally, you can try using other layer styles to make the 

icon's colors more vibrant and lively. At this point, the editing of this 

image is basically complete... or is it? 

It can be observed that after the above editing, the image still 

exhibits a paper or plastic sheet texture. Therefore, we need to 

further adjust the material using Camera Raw. 

Camera Raw is located in the "Filter" dropdown menu at the top 

of the Photoshop window.  Once opened, you can adjust various 

values ​​to modify the image's texture, primarily exposure, contrast, 

 



 

texture, clarity, vibrance, and saturation. Other settings can be 

adjusted as needed. 

 
Figure 12: The numerical values ​​can be adjusted as needed and do not need to be copied exactly. 

Subsequently, we can also create a new layer for the image 

element by right-clicking the layer menu and selecting "Create Layer 

Style via Copy." Then, we can individually extract Mr. Wei's arm within 

the smart object, separating it into two layers for individual editing to 

enhance the sense of depth. 

Note: Please use layering judiciously. Excessive layering may lead 

to software lag and significant storage space consumption, and 

severely impact future adjustments. If the desired effect can be 

achieved without layering, or if the effect of layering is not significant, 

then there is no need for layering. 

After a series of adjustments, Mr. Wei finally became more 

lively/vibrant. 

 



 

 

 

Finally, we group these separated layers together using the 

"Create New Group" option in the lower right corner of the interface. 

Then, we create a  layer mask for the newly created group and 

use a low-hardness brush to soften the straight edges of the image 

elements. By using a layer mask to paint over the group, we can 

eliminate unwanted parts and blur the edges, preventing the blurred 

edges from turning black or white due to the influence of layer styles. 

 
Figure 13 

The icons should not have harsh, abruptly cropped straight 

edges like the example shown below.  The edges should appear soft 

and smooth, and the design shouldn't be overly complex or 

time-consuming; a moderate level of detail is sufficient. 

 



 

 
Figure 14: A negative example. Thanks to @oErmOS for providing it. 

Then, you can save the PSD file by going to File > Save. After 

completing each part of the process, you should save the file 

promptly to prevent losing your progress due to unexpected events. 

Step 4: Completing the Composition 

Okay, now we've successfully placed Mr. Zhang on the canvas, but 

we can't just leave him all alone there, can we? 

As a veteran of this tutorial series, I've decided to have Zhang 

Weiwei become part of this icon as an artist. 

In other words... 

 



 

 
Figure 15  Hmm... the apron and beret images are from Taobao – furniture and clothing materials 

can be obtained there. 

 

 

So the question is, how can we get Zhang Weiwei to "wear" this 

outfit? 

 



 

 
Figure 16 

It's noticeable that this apron isn’t very fitting.  At this point, we 

can enter the free transform mode, hold down the Ctrl key, and drag 

the four corners and four sides to adjust the perspective of the image 

until it fits. Then, use a layer mask to erase the unnecessary parts. 

Afterward, adjust the position and size of the other elements until 

they are roughly in the correct place. 

 
Figure 17 

 



 

 
Figure 18 

Next, before finalizing the overall composition of the icon, we can 

try incorporating the golden ratio into the creative process to help 

guide the compositional design. 

 
Figure 19 

 

 

Using this method, we can transform complex icon compositions 

into simple fill-in-the-blank exercises.  By simply collecting the 

necessary assets and placing them into the three designated slots on 

the canvas, the composition can be completed quickly. However, it's 

important to note that during this "filling in" process, attention must 

 



 

still be paid to the spatial relationships and overlapping of the assets 

to avoid them being separated and resulting in a loose or disjointed 

icon. Furthermore, try to ensure that the icon largely fills the 

available space on the canvas, avoiding large gaps exceeding 1/8 of 

the total area. This will ensure that the icon appears consistent in size 

when implemented in the game. 

 
Figure 20: The TFR-chan illustration is from @PISXIV9966. Thanks to @Liu1571498750 and 

@orangestar17 for their help. 

By following the image editing steps described above (or you can 

simply right-click the layer, copy the layer style, and paste the layer 

style), we can process the remaining materials in the same way and 

then save the file. 

 



 

 
Figure 21: The TFR character illustration is from @PISXIV9966, and the apron and beret are from 

Taobao. 

(Yes, Taobao. You can find furniture and clothing materials there.) 

This icon is nearing completion, but it still has some serious 

problems: it lacks depth and dimensionality overall, and is far from 

being a satisfactory TFR icon.  Further adjustments are needed to 

complete this icon. 

 

 



 

Step 5: Final Adjustments 

First, we can manually draw shadows on the parts of each 

element that are obscured by other elements using a black brush to 

enhance their sense of depth. 

 
Figure 22: Shadows can be added appropriately to areas that are backlit, far from the light source, 

inherently dark, or obscured by other layers. 

The previous layer styles and Camera Raw settings can also be further adjusted. 

Subsequently, we can create  adjustment layers. After placing 

all the icon layers into the same group, you can apply a clipping mask 

to the group to make post-production adjustments to the overall 

effect of the icon. Next, I will briefly introduce several commonly used 

adjustment layers: 

Hue/Saturation can be used to adjust the color and saturation of 

icons, and can also adjust the saturation and hue of a specific color 

individually. Vibrance adjusts the overall saturation and natural 

saturation of the icon. 

Brightness/Contrast adjustments can modify the overall 

brightness and contrast of a layer, addressing issues such as icons 

being too bright or too dark, or having low contrast. 

Gradient mapping allows you to color the entire icon based on its 

 



 

brightness, mapping different brightness levels to different colors 

(typically mapping the left side to darker areas and the right side to 

brighter areas), thereby achieving color adjustment and special 

effects. The specific gradient colors and layer blending modes can be 

adjusted according to the actual situation. 

Color lookup allows you to quickly adjust the tone and style of an 

image. By using preset color lookup tables (LUTs), you can add 

different color effects to icons. You can obtain color lookup tables 

from various graphic design communities. 

Color balancing allows you to adjust the colors of highlights, 

midtones, and shadows in an icon separately to correct color 

imperfections or create specific color effects. 

Using adjustment layers avoids the need to individually adjust 

each layer's elements to modify the icon's style and tone, significantly 

reducing post-production work. For more information on adjustment 

layers, you can search for related tutorials on various video websites. 

 

 
Figure 23: The previous layer styles and Camera Raw settings can be further adjusted. 

The hat was colored using a Color Overlay – Hue blending mode. 

 



 

New graphic designers often encounter issues during icon 

creation where assets and effects extend beyond the canvas 

boundaries, resulting in cropping at the edges, as shown in the 

background image of the party flag below. 

To avoid this, you can create a pure black and a pure white layer 

at the bottom of the layer list to check if any glow effects or assets 

extend beyond the canvas boundaries, ensuring that no assets or 

effects are cropped by the canvas edges. 

 

 
Figure 24: A negative example, thanks to @FCC for providing it. 

And just like that, a standard TFR-style icon is complete. Save the 

PSD file and export the icon as a PNG image, then hand it over to your 

beloved developer to integrate it into the project. 

 
Figure 25: It’s finished... or is it?  

 



 

2.  Advanced Editing Techniques: 
One of the biggest characteristics of the new generation of TFR 

icons is that they extensively utilize new processing techniques to 

optimize the overall visual appearance of the icons. 

It's important to note that the purpose of advanced processing 

is to optimize the overall appearance of the icon; in other 

words, these processes are not necessary steps in creating TFR 

icons. If excessive glare, over-smoothing, or smoke effects actually 

reduce the icon's legibility and make the image look messy and 

cluttered, then something has gone off track. Furthermore, I 

recommend that you begin learning the content of this chapter only 

after mastering the basic skills and fundamental Photoshop 

operations and techniques mentioned above. (Translator’s Note: 

Bondrewd is talking about 1. Basic Editing Techniques) Don't expect 

to achieve everything overnight or try to learn everything at once. 

In this chapter, I will start with a simple neon effect and 

introduce some advanced material processing methods. The 

following steps do not need to be performed in any particular order; 

you can follow your own preferences or whatever your situation calls 

for. 

 

 



 

Neon Effects 
If we want to transform the TFR logo on the canvas into a 

neon-effect layer, we can add the following layer styles as shown in 

the image below: 

 
Figure 26: The colors can be freely combined, but the inner color must be lighter than the outer 

 



 

color to achieve the neon light effect. 

 

Subsequently, the layers can be placed into a group, and a 

gradient overlay with a hue/color mode can be added again to create 

a gradient neon effect. 

 
Figure 27 

Finally, add the lighting effects according to the following tutorial 

to complete the neon light effect, and then save the file.

 



 

 

Figure 28: Is always worth revisiting; thanks to Trun for providing the tutorial. 

 



 

 
Figure 29 

Flame Effects 

The process for creating the flame effect is similar, with some 

overlapping techniques, and both methods utilize light processing 

with the `trun` function. 

First, drag and drop the flame asset onto the canvas. Since we 

want to create purple flames, we need to use color overlay – 

specifically, hue coloring. This step can be omitted for normal orange 

flames. 

 
Figure 30 

Duplicate the layer, change the blending mode to Screen, add a 

filter—Blur—Gaussian Blur, and place it below the original layer. 
 



 

 
Figure 31 

Duplicate the layer and move it to the top of all the assets. 

Change the blending mode to Linear Dodge (Add) (you can also use 

Screen or Hard Light depending on the situation). You can also add a 

blur gallery effect—Path Blur—to simulate the effect of rising flames. 

Adjust the values ​​and path settings as needed. The previous neon 

effect can also be enhanced with trailing or motion blur effects using 

the same method. 

 
Figure 32 

Use a layer mask and a soft black brush to paint over the 

unnecessary parts. 

 



 

 
Figure 33 

Subsequently, further adjustments can be made as needed. 

  
Figure 34 

Finished. Save the file. The above steps can be adjusted 

according to your specific needs; everything depends on the final 

result you want to achieve. 

 
Figure 35 

 



 

Simple Cloud and Fog Effects 

Drag and drop the cloud and fog assets to the appropriate 

position on the canvas, erase any unnecessary parts, and then adjust 

the opacity as needed. 

 
Figure 36 

Next, duplicate the layer and add a Gaussian blur, then drag the 

duplicated layer below the original layer. You can then place it in a 

layer group, make minor adjustments using a clipping mask, save the 

file, and you're done. You can also try adding a path blur to make it 

look more dynamic. 

 
Figure 37 

 



 

 
Figure 38 

Rim Lighting 

Hold down the Ctrl key and left-click on the layer with the mouse 

to load the layer selection (as shown in the image). 

 
Figure 39 

Then, in the top menu bar, click "Select" > "Modify" > "Feather," 

and set the feather radius to 4 pixels. Create a new layer above the 

image, set the layer blending mode to Linear Dodge (Add), and then 

use a brush with 0 hardness and 50-70% opacity to paint along the 

edges of the selection with a color corresponding to the desired 
 



 

lighting effect. 

 
Figure 40: Doesn't require much paint; just lightly dab some paint in the areas where the light 

effect is needed. 

Then, the same method was used to process the other backlight 

materials, the files were saved, and the process was complete. 

 
Figure 41 

Manually-added Shadows and Highlights 

When faced with materials that lack depth and appear too flat 

(or are inherently two-dimensional), or when the light and shadow 

areas of the material don't match the light source position, you can 

 



 

try manually painting in highlights and shadows after adjusting the 

image in Camera Raw.  

 

It’s important to note that you don’t need to redraw the original 

TFR-style material into a “metal sculpture” (heavily stylized look with 

strong bevels, deep shadows, and rigid highlights). You simply need 

to use a black or white brush with 30% opacity and 0 hardness to 

paint shadows in areas that are backlit, away from the light source, 

inherently dark, in clothing folds, or where other layers or parts of 

the material itself are obscuring the area.  Paint highlights in areas 

illuminated by the light source, areas that are inherently brighter, or 

protruding areas. You can also add outlines to the edges of different 

parts of the material to achieve a more three-dimensional effect 

compared to the original material. If the edges of the highlights and 

shadows are too harsh, you can use the blur tool to soften them. 

This step can eliminate some of the layering steps; it's 

recommended to choose the method that is relatively more efficient 

based on your preferences. After simply applying the changes, save 

the file and export the icon as a PNG image. 

 



 

 
Figure 42: This can be drawn simply; it doesn't need to be too complex. 

Cyan represents the shadows, and yellow represents the highlights. 

 
Figure 43: Another example from ahneo. 

Light blue represents stronger, larger shadows, red represents finer shadows, and green 

represents highlights in overlay/screen blending mode. 

Still use a black or white brush with 30% opacity and 0% hardness for drawing. 

 
Figure 44: Here’s a comparison. In most cases, if a problem can be solved using Camera Raw, it's 

best to avoid manually adjusting highlights and shadows. 

As a reminder, you should avoid spending too much time and 

effort on this step. Not every part mentioned above needs to be 

drawn, and you don't need to draw every single element. If Camera 

 



 

Raw can achieve a good result, then there's no need to spend 

excessive time on this step. Finally... remember to save frequently 

while drawing highlights and shadows. 

Flag Editing 

In this section, I will briefly explain how to edit flags. Many 

thanks to AhNeo for his guidance in handling this part and writing 

the tutorial. 

First, place the flag image you want to edit onto the icon canvas 

and add basic layer effects. You'll notice that the flag appears very flat 

at this point, like a piece of cardboard with a flag pattern printed on 

it. 

 
Figure 45 

Next, use a black brush (75% opacity, 20% flow; these settings 

can be adjusted as needed) to color the darker areas. Then, switch to 

a white brush with the same settings and apply color to the 

unpainted areas and the raised parts of the folds. Perfection is not 

necessary at this stage, as the main goal is to establish the basic light 

 



 

and shadow relationships. 

 
Figure 46: Painted with a black brush. 

 
Figure 47: Used a white brush. 

You can then try adding some extra shadows and highlights, and 

add some larger, softer shadows below the flag or in the backlit areas 

to give the flag more depth.  You can also use blurring to refine some 

of the details. 

 
Finally, adjust the brightness, contrast, and saturation settings as 

 



 

needed, then save the file and proceed with other processing steps. 

 
Figure 48 

(To be continued) 

3. Other Related Icon Designs： 
在学会国策图标创作后，当你再上手去制作剩下的其他类型图

标时，一般情况下都不会遇到太多困难，只需要在限定画布中完成

创作即可。不过针对不同类型的图标，仍有一些需要注意的事情，接

下来我将分别进行讲述。 

 
图 49 

 



 

  (1). National Spirit 

Typically, national spirit icons need to be created on a 68*68 

pixel canvas.  Graphic designers must clearly express the theme of a 

national spirit within this limited space. The national spirit icon 

should fill the entire canvas as much as possible, while also 

maintaining a consistent visual style with other national spirit icons, 

as shown in the image below: 

 
Figure 50: Praising Neru 

Aside from this, there are no significant differences between the 

production process of national spirit and national focus icons; the 

only requirement is to ensure that the icons clearly convey their 

themes. Regional modifiers are very similar to national spirits, so we 

won't go into further detail here. 

  (2). Ideology 

Ideological icons, compared to national policy icons, will feature 

more pronounced contrast and metallic textures, ensuring that they 

can express the maximum characteristics of an ideology or political 

system on a 68*68 pixel canvas. 

 



 

 
Figure 51 

As shown in the image, TFR's sub-ideology icons typically do not 

use excessive neon or flame effects; the overall texture resembles a 

badge, giving it a more three-dimensional and layered appearance. In 

terms of color scheme, the gradients and colors of the ideology icons 

are also richer. AhNeo has provided a PSD file of his ideology icon, 

which you can find in the quick start package. 

  (3). Balance of Power 

The production process for power balance icons is very similar 

to that of national policy icons. The only thing to note is that power 

balance icons are usually positioned at opposite ends, so the two 

icons should complement each other as much as possible. You may 

need to incorporate some clever design elements into the 

composition. 

  (4). Texticon / Small Icons 

To clearly represent things like political parties, political forces, 

specific resources, military-industrial organizations, or other 

mechanisms on a tiny canvas smaller than 50*50 pixels, you need to 

try to achieve the best possible effect with the fewest elements, 

avoiding too much clutter that would result in an indistinguishable 

 



 

mess. 

 

4. Precautions 
Here, I will compile some common problems and misconceptions 

I've encountered during past graphic design exchanges and learning 

sessions, along with relevant precautions, to help new graphic 

designers avoid common pitfalls during their learning process. 

  (1). Ensuring consistency and harmony in color scheme and 

style 

When creating icons for a national focus tree, you need to ensure 

that your icons match the overall color scheme and style of the entire 

focus tree, maintaining a consistent and harmonious appearance. A 

national focus tree primarily using red should not have green icons, 

and vice versa. 

  (2). Balancing efficiency and quality 

Many graphic designers try to pour as much effort as possible 

into each icon to ensure it's perfectly presented to the players. While 

striving for excellence is commendable, every graphic designer needs 

to understand that they might spend hours on a single icon, but 

players won't. Players won't be scrutinizing every tiny detail and 

nuance of your icons with a magnifying glass, so there's no need to 

spend excessive time creating flawless icons. What most mods truly 

 



 

need is a large number of usable icons. 

  (3). Avoiding Excessive Editing 

Whether adding lighting effects or drawing highlights and 

shadows, the purpose of these advanced techniques is to present 

players with a clear and recognizable icon that effectively conveys its 

meaning.  Players should be able to understand the icon's meaning at 

a glance. If the edited icon becomes blurry or difficult to discern, then 

a new approach needs to be considered, or the icon should be 

abandoned altogether. 

  (4). All writings in the world are essentially plagiarized. 

(Translator’s Note: AKA “Inspiration”) 

When you're lacking creative ideas and don't know where to 

start, you can try referencing the composition, material selection, and 

processing techniques of other excellent works. While studying other 

people's work, try to understand "why the creator did it this way," 

thereby absorbing and internalizing mature ideas from other 

designers and overcoming creative blocks. 

  (5). Experiment and innovate more 

There is no single correct approach to creative work.  While 

mastering fundamental skills and ensuring the quality of the final 

product are essential, you can and should experiment with new 

techniques.  Innovations in composition and editing can inject new 
 



 

vitality into community-based fan art creation. 

  (6). Other Precautions 

●​ If you want to create a new icon based on one you've made 

before, you should immediately save the project file with a 

new name in a suitable location to avoid overwriting the old 

icon; 

●​ It is recommended to try using reliable third-party software 

to block Photoshop's network connection, to avoid being 

prompted by Adobe to purchase a genuine copy of 

Photoshop; (Translator’s note: If you aren’t up to doing this, 

just something like photopea) 

●​ The reason Photoshop might not be displaying the brush 

cursor is that you have Caps Lock turned on. 

●​ In the Edit > Preferences > Scratch Disks section, you can set 

the scratch disk to a different drive to avoid occupying space 

on the system drive. 

 



 

 
Figure 52 

●​ It's okay to incorporate pop culture references into the icons, 

but don't make them offensive or inappropriate. 

●​ Just a reminder again, remember to save your work 

frequently. 

 

5. Conclusion 
Thank you for reading this tutorial. We hope you've learned how 

to create a simple TFR-style icon. However, regardless of the style or 

type of icon, mastering icon creation requires long-term practice and 

experience. When you feel you've gained sufficient skills, consider 

joining the TFR development team or other community projects to 

contribute to the growing flame of creativity—and simultaneously 

hone your skills to create even higher-quality works. 

 

 



 

Appendix 

Collection of useful websites and tools 

Here I have compiled some commonly used tool websites. Due to 

the nature of some websites, they may have become unavailable due 

to copyright or other issues by the time you read this tutorial. Please 

understand. 

I will specifically mark those that require a VPN to access in 

mainland China. 

Images 

1​ https://www.miankoutupian.com/ 

Free PNG Images website, containing a large collection of 

royalty-free PNG images. 

2​ https://www.pngegg.com/ 

Another website for PNG image resources (requires a 

VPN/proxy). 

3​ https://www.the-blueprints.com/ 

Includes a large amount of side-view images (direct 

connection speed is slow, using a VPN is recommended). 

4​ https://www.irasutoya.com/?m=1 

Japanese free stock image websites (requires a 

VPN/proxy). 

5​ https://krikienoid.github.io/flagwaver/ 

 

https://www.miankoutupian.com/
https://www.pngegg.com/
https://www.the-blueprints.com/
https://www.irasutoya.com/?m=1
https://krikienoid.github.io/flagwaver/


 

Generate a waving flag; you can change the flag and adjust 

the wind speed and direction settings.  Screenshots can be 

taken (requires a VPN). 

6​ https://www.alamy.com/ 

https://downpic.cc/alamy/ 

Download images from Alamy without watermarks. 

(Direct connection speed is slow; using a VPN is 

recommended.) 

7​ https://ziyouziti.com/ 

https://zfont.cn/ 

https://www.fonts.net.cn/ 

Free font websites 

8​ https://www.doubao.com/ 

Doubao is a Chinese AI that can generate images, and its 

use should comply with Chinese cultural, ethical, and legal 

restrictions. 

https://gemini.google.com/ 

Gemini, an AI from the United States, should be used in 

accordance with American cultural, ethical, and legal 

restrictions. (VPN access may be required.) 

This seems to imply you'll face restrictions on both sides 

of the Pacific simultaneously, but consider it from a 

different perspective: you can use Chinese AI to 

 

https://www.alamy.com/
https://downpic.cc/alamy/
https://ziyouziti.com/
https://zfont.cn/
https://www.fonts.net.cn/
https://www.doubao.com/
https://gemini.google.com/


 

circumvent restrictions from the US, and American AI to 

circumvent restrictions from China, thus enjoying the 

benefits of technological advancements on both sides of 

the Pacific. This applies not only to Doubao and Gemini, 

but also to other large AI models from China and the US. 

Of course, if you have a sufficient budget, using locally 

deployed AI image generation models can avoid all of 

these problems. 

9​ https://bylo.ai/ 

Free GPT-4o AI image generation website (requires a 

VPN/proxy). 

10​ https://lmarena.ai/ 

Free GPT/Gemini image generation, available without 

logging in.  Find it in the menu bar below and 

select the option for image generation (requires a 

VPN/proxy). 

Editing tools 

1​ https://dewatermark.ai/ 

https://www.watermarkremover.io/ 

Watermark removed, excellent graphic design skills. 

2​ https://clipdrop.co/relight 

Relighting (requires a VPN) 

 

https://bylo.ai/
https://lmarena.ai/
https://dewatermark.ai/
https://www.watermarkremover.io/
https://clipdrop.co/relight


 

3​ https://www.remove.bg/zh 

https://www.koukoutu.com/removebgtool/all 

Quick one-click image background removal 

4​ https://clipdrop.co/remove-background 

https://www.photoroom.com/tools/background-remover 

Quick one-click image background removal (requires a 

VPN/proxy). 

5​ https://myedit.online/cn 

A collection of AI tools (requires a VPN/proxy). 

6​ https://replicate.com/ 

Portrait restoration 

Production Methods 

1​ https://tfr.997779.xyz (Translator’s note: The link is 

broken) 

TFR custom super event displayer, the font differs slightly 

from the official font. 

2​ https://flag-creator.com  

A website for creating fictional national flags, containing a 

large collection of flag designs. 

Others 

1​ https://www.mediafire.com/ 

A free file uploading and sharing website, used to 

 

https://www.remove.bg/zh
https://www.koukoutu.com/removebgtool/all
https://clipdrop.co/remove-background
https://www.photoroom.com/tools/background-remover
https://myedit.online/cn
https://replicate.com/
https://tfr.997779.xyz
https://flag-creator.com
https://www.mediafire.com/


 

circumvent Discord's file size limits, but sometimes the 

download speed is slow (a VPN or proxy is required). 

2​ https://drive.google.com/ 

Google Drive is faster than MediaFire (a VPN or proxy is 

required). 

Related tutorial links 

Here I've compiled some links to GFX tutorials created by other 

graphic designers on Google Docs. 

1.​ https://docs.google.com/document/d/1QtOWUDKS4mQHEi

SBlSmrULQQ5OwRWOG39yAzYeCwxG0/edit?usp=sharing 

Portrait tutorial from Svblockz 

2.​ https://docs.google.com/document/d/e/2PACX-1vTrESXQF

CpOSs7yRTWp4MTIJEnvv1vuBExBRsrvitO76l_aogKnHfXn4U

11DWsSx-LIYvRiCQoIyi23/pub 

Portrait tutorial from Idenn 

3.​ https://docs.google.com/document/d/1GiPZ05FinCLI6Qwu

oXuS0b9MpkX9dJFJBE14XJZxoxo/edit?tab=t.0 

Portrait tutorial from Increditard 

4.​ https://docs.google.com/document/d/1gVivS972B90vBGxL

rx0eBfyY7S9qQPwgds15yQhs0fQ/edit?usp=drivesdk 

Icon tutorial from Rev 

 

https://drive.google.com/
https://docs.google.com/document/d/1QtOWUDKS4mQHEiSBlSmrULQQ5OwRWOG39yAzYeCwxG0/edit?usp=sharing
https://docs.google.com/document/d/1QtOWUDKS4mQHEiSBlSmrULQQ5OwRWOG39yAzYeCwxG0/edit?usp=sharing
https://docs.google.com/document/d/e/2PACX-1vTrESXQFCpOSs7yRTWp4MTIJEnvv1vuBExBRsrvitO76l_aogKnHfXn4U11DWsSx-LIYvRiCQoIyi23/pub
https://docs.google.com/document/d/e/2PACX-1vTrESXQFCpOSs7yRTWp4MTIJEnvv1vuBExBRsrvitO76l_aogKnHfXn4U11DWsSx-LIYvRiCQoIyi23/pub
https://docs.google.com/document/d/e/2PACX-1vTrESXQFCpOSs7yRTWp4MTIJEnvv1vuBExBRsrvitO76l_aogKnHfXn4U11DWsSx-LIYvRiCQoIyi23/pub
https://docs.google.com/document/d/1GiPZ05FinCLI6QwuoXuS0b9MpkX9dJFJBE14XJZxoxo/edit?tab=t.0
https://docs.google.com/document/d/1GiPZ05FinCLI6QwuoXuS0b9MpkX9dJFJBE14XJZxoxo/edit?tab=t.0
https://docs.google.com/document/d/1gVivS972B90vBGxLrx0eBfyY7S9qQPwgds15yQhs0fQ/edit?usp=drivesdk
https://docs.google.com/document/d/1gVivS972B90vBGxLrx0eBfyY7S9qQPwgds15yQhs0fQ/edit?usp=drivesdk
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